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iSeries AD N >
\/ NewPackagiing

\/ Newdiechnelog
v

\/
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New Packaging: V5RL

_ VBRIIGT222WDS
WebSphere Development Studio sz s7g9- s

Eee

RS - ADTS @pgrade
WIth'SSs!

Host

COBOL C++

WebSphere Development Tools

VAJava ' CODE/400|

DD Client

WDT
UPPLIMITED LICENSES)




CODE/400

=Y
iISeries AD, IBM Toronto

$

v/ Next Generation of ADTS:

e CODE Editor

DDS, Java, VARPG
(SWESEY  » program Verifiers for RPG, COBOL, DDS
v Quaranteed clean compile, first time
_ » Language Reference manuals online, F1 enabled
wa=l]Vl ¢ CODE Remote Compile
» Remote Compile with Error Feedback
» GUI Compile Options Dialogs
(ISVRSIPIAY o« CODE Designer
RIEU » WYSIWYG design of DSPFs, PRTFs, PFs

= * CODE Distributed Debugger
=repjeie| > Remotely debug RPG, COBOL, CL, C, C++, Java

e CODE Project Organizer
g2 PRVl  » Random filtered access to QSYS and local files

option 14

» Language aware editing for RPG, COBOL, CL, C, C++,

IBM @server. For the next generation of e-business.



VisualAge RPG KM
v/ VARPG: Client and GUI RPG!

e VARPG Compiler and Runtime

sl > In synch with VAR4 RPG IV (V5R1 to come)
. | » Compile and run on Windows or
WileloWsi  » compile and run as Java (run anywhere!)

e VARPG Debugger

: e VARPG GUI Builder

IREC\ith » Visually layout Graphical User Interface
GUJ » Program event logic ... in RPG

| e CODE Editor
» Shared with CODE/400

el o Non-Visual projects supported too
BPEI » Possible to write %100 portable business logic in RPG!

CONVErL
VARPE 1.6

Javal

IBM @server. For the next generation of e-business.



New Packaging _
W Bulld Community!

/" Common tools for entire community
/" BPs/ISVs can pre-req. No stack price $

J’ Bulld Excriement!

/ Best-of-breed tools for modern apps
/" WebFacing: RPG->Web in minutes!
\/ Massive enhancements to compilers

IBM @server. For the next generation of e-business.




QUIG TTIDWJIL Y . . . JUIIG
%

/|'

Newiiechnoleg

#1. Integrated Development Environment
REG Y/ Javay/. Wen
(COBOL + T EACINEG

— Next Release of WDT

N iRee) ks

o #2. New Tools for New Technolog
2 -
SEIVICES
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QUITIG THIDWJI Y « .« « JUIIT
K
|

iISeries AD, IBM Toronto

WDT V5R1 becomes WDSc 4.0

40
WDSc was the first phase of tool

implosion!
VAJava

Studio

INEW

IName!

INEeWw.
Neo)gl

S

IBM @server. For the next generation of e-business.
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WS Workbench

iISeries AD, IBM Toronto

v WebSphere Studio Workbenchiis:
e Superset of eclipse. Not for sale

e Basis of all IBM AD products. EQ:
»WebSphere Studio Site Developer

»WebSphere Studio Application Developer
»\WebSphere Studio AD Integration Edition Advanced

e Available to IBM Business Partners

» Via IBM PartnerWorld:
v To build/test plugins
+To create products ADIE

-+ /|

Standard

Each product is a different

"configuration" of WebSphere WSWB S rv/es

Studio
» Refers to product family Java Web + DB

.PRZ 11
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VYWUIL QL iuicu U VeI D1UIl1
5

iISeries AD, IBM Toronto:

Newriechnoelegy, Newileols

v New IDE Is based on WSSD

WIDSE

WebSphere Development Studio Client 5.0

\/ WSSD 1s based on eclipse!
e m Web
DB Tools

WebSphere Studio Site Developer
IBM @server. For the next generation of e-business.




iISeries AD, IBM Toronto

v Roughly =
e classic VAJava Pro
- « classic WebSphere Studio Standard
-+ ¢ new WAS 5.0 Test Environment
-+ « new tools for Servers, XML, Web
Services and Database design

WelgsSanere sitjelie Slte DEVEIGPE
Team

& Plugin {| Java Web || AppSrvr | WebSvc || XML || DB
Ul F/W Tools Tools Tools || Tools Tools || Tools {| Tools

IBM @server. For the next generation of e-business.




WDSc 5.0 Standard!

iISeries AD, IBM Toronto

WebSphere Development Studio

ADTS

] Host
— . WDSc :
IWSSENSEIIESHIO0IS Client
Team WAS Unit Test Environment

Projects || Plugin || Java Web
Ul F/W || Tools || Tools Tools

AppSrvr ||WebSvc|| XML || DB
Tools Tools || Tools || Tools

[SENES [SENES [SENES [SENES
PI0JECtS EXINS EXINS EXINS
REMOIE
S)EIE WEBEEICING
EXPIOIEN

.PRZ
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5

iISeries AD, IBM Toronto:

Newriechnoelegy, Newileols

v New IDE Is based on WSAD

WIDSE

WebSphere Development Studio Client 5.0

|
\/ WSAD iIs based on eclipse! Web, XL

WSAD

IBM @server. For the next generation of e-business.
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WSAD

iISeries AD, IBM Toronto

WhseAdvanced!

v Roughly =
e VAJava Pro & WebSphere Studio Standard
e new WAS 5.0 Test Environment
e new tools for Servers,
e XML tools
e Web Services
e Database design tools
e Profiling tools
e tracing tools
e EJB tools
e Struts builder

PRZ 16
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WDSc 5.0 Advanced!

iISeries AD, IBM Toronto

WebSphere Development Studio Advanced Edition

Host

RPG |/|COBOL C C++ ADTS

/,,,
WDSc Advanced A—

Waosonzra siudio Avolication Davyalggar

— 1S2ries T9ols WAS Unit Test Environment

Projects | Plugin || Java | Web Btruts [EJB AppSrvr|WebSve| XML || DB ||Profiling|(Tracing
Ul W Tools || Tools | [Tools |[Tools ({Tools Tools | Tools [Tools|{Tools| Tools || Tools

4 o a . *r“rra "ﬂr"r"& ‘:‘r"r:a
[SENES [SENES ISEIES 1oEfIEs

S
a . . 0 F\ rr) e
=I0|ECLS EXUAS EXUIS =AUNS

RENOIE!
SYSIEN
EXIIOET

Weareiite Tl

SHUISCOMPIARAUNLTIE C I e nt

YAREE

.PRZ 17

IBM @server. For the next generation of e-business.



What's new in Version 5.0

iISeries AD, IBM Toronto

B \WebFacing Tool enhancements for scalability, performance and ease
of conversion

B Significantly enhanced support for iSeries file systems, projects,
editing, compiling and debugging inside the Eclipse IDE

B \Wizards generate robust Struts-based Web apps that can be easily
extended using a new visual development environment

B Supports open standards such as J2EE, XML, SOAP, WebServices,
WSDL and Struts

B Improved interfaces to integrate 3rd party tools to the new IDE
B New customizable views of tools and data to help organize your work.

B Concurrent support for WAS 3.5.6, WAS 4.0, WAS 5.0, WAS
Express 5.0 and Tomcat

B Unit test environment for WAS 4.0, WAS 5.0 and WAS Express V5
mJDK 1.3, JSP 1.2, Servlet 2.3
B \Web: Visually construct MVC-based Web applications

B \Web services: Support for UDDI V2 and discovery via Web Service
Inspection Language (WSIL)

.PRZ 18
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WDSc: eclipse

iISeries AD, IBM Toronto

»eclipse ... The base!

.PRZ 19
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eclipse Sié

eclipse.org

v eclipse is the IDE technology engine
e fully open-source @ www.eclipse.org
e created by IBM
® huge interest: > 500,000 downloads
e written Iin Java
e easily extended by plugins

Welgsionarasiiticlio Siia Davalgoar Aclzigeae
ECIIPSE

Plugin || Java Web [| AppSrvr || WebSvc|| XML || DB
UI F/W Tools Tools Tools || Tools Tools || Tools {| Tools

generation ol e-




hame

arganization

projects
dawunloads
articles
Mersg rou ps
mailing lists
zaarch

bugs

EClIPSErere
consertitm

li E (=4 g% ﬁ |http:,.",."www.eclipse.curg

What i= eclipse.org?

The eclipse.arg Conzartium was formed to deliver newera application development toals. Industny leaders Borland, 186,
Merant, QMX Sofhware Systems, Rational Software, RedHat, SusSE, TogetherSoft, and Web&ain form the initial
eclipse.org board of directors. These companies plan to release Eclipse Platform compatible product offerings.

In the Eclipse Platform, code access and use is controlled through the Common Public Licen5e1. which allowes individuals
to create derivative wods with worldwide re-distribution rights that are rovalty free.

Az with other open source communities, eclipse.org brings together the broad padicipation needed to establish, refine,
and promote high-quality shared software technology. fore than 1,200 individual dewvelopers from over 150 leading
zafhmare tool suppliers in G323 countries have already padicipated in the eclipse.org community.

0 gome compoke i ofeclpee ong dow koads maybe goue ried by e ke s otber thaw the CPL.

Board members

For more information about member arganizations and theirsuppor for Eclipse.org, click the following links.

= SuSE
DO MERANT TogetherSoft

S O webGAIN|

a more
reliable
wiorld

Rational

the software development company




eclipse y

eclipse.org

v eclipse plus plugins = product
¢ although its a great Java IDE as is!

v eclipse will be basis of many products
e from I1BM, BPs, ISVs, anyone!

&/ v eclipse is ahuge opportunity
e for writing + selling plugins

Plugin| | Plugin | | Plugin

Plugin Plugin

eclipse

Plugin

Plugin
|
Plugin || Ul F/W || Tools {{ Tools | | Plugin

.PRZ 22
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wosc: RPG/CBLTools IR

s AD, IBM Toronto

» RPG and COBOL Tools
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WDSc: RPG and CBL Tools

iISeries AD, IBM Toronto

v/ Remote Systems Explorer Perspective

e Random drill-down or filtered access to remote:

» QSYS Libraries, Objects and Members
» |FS Folders and Files
» Linux, Unix, Windows and Local Folders and Files

e Remote command execution of

» QSYS Commands and QSHELL Commands
» Linux, Unix and Windows Commands

e Exploration of Jobs in QSYS
v/ 1Series Projects and Perspective

e For structured, project-based development
e Local team-sharable project
e Holds source files, members and save files

e Each project associated with an i1Series and library
» Push action to copy local files to associated library

PRZ 25
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WDSc: RPG and CBL Tools

iISeries AD, IBM Toronto

v/ Remote Systems Explorer Perspective

e Manages connections to remote systems

» Where you create/manage connection
Information

» Connections subsequently used in all iISeries
tools

» Start by using the New Connection wizard

v Connection appears in tree view
v Expand It to see "subsystem” -> functional
groupings

.PRZ 26
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WDSc: RPG and CBL Tools

- ¥ Remote Systems Explorer - Development Studio Client

New Connection
File Edit Perspective Project ‘Windomw Help

. ]
S HEE (XS] ‘REMOLEISYSIEMSNVIEW:
E E Remote Syztems ‘ ShOWS a” eXIStIng

Remote System Connection

Define connection information

Parent profile: In::l:uulthar |% % Eew IEDnne::tiun... Connecuons
il By e Expanalte drill dewn

Connection name: |My i5eries -, iSenies Objects

- Series Commands Right click 10 do actions
P Sl Commands\View;

Legs all commeanas and resulis
Canypencommanc o R remotely;
(CHNOESE CONNECHON 1o N
EEasilyiecallicommands

System type: iSernes

Host name: taranta

o o €l S

Default User |D: Jn:n:lulthad

Dezcription: I

NewConnection

= Properties B = :

leard Froperty | Yalue E& Commands
Connection status Mo subzpstems conn
Default Uzer 1D COULTHAR [Inkerite
D escription
Hozt name TOROMTO
Mame by iSernesz
Mumber of children 4 ﬂ
Farent prafile coLlthar — —
Femate system type S eries IM-"J i=eries j I'SE"ES Eummannj I
Tune Cormechinm
Commands | Tasks | Outling | iSeres Job Log

Connectian

IBM @server. For the next generation of e-business.
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What's new in Version 5.0

iISeries AD, IBM Toronto

ISeries Projects...

= Conflict Detection

» Remote source changes are shown in the iSeries project with different file icon

» User is warned before pushing local changes to remote system if remote source
has changed

= Build Styles
» Presupplied:
= Command
= CL Build Style
» Integrated error feedback
= |SV Integration Support
» APIs for ISVs to create and manipulate iSeries projects
» [SVs can provide:
= Additional pages to the new iSeries project creation wizard
= Additional build styles
m |[ntegration with RSE
» Create projects from the RSE
» Add members to existing projects
» Program verifiers
» Remote Systems LPEX Editor

.PRZ 30
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What's new in Version 5~0!

iISeries AD, IBM Toronto

Remote System Explorer...

= Editing
» Remote Systems LPEX Editor
= Syntax checking
= Context sensitive help
= QOutline view
= Code assist
= Indentation view
= Program verifiers
» Ability to use any Workbench editor on any remote source
= Remote Systems LPEX Editor, Java editor, XML editor, SQL editor
= Debug
» iSeries remote debugging integrated into the Workbench
= Enhanced iSeries table view
» More PDM like user interface and actions
= Drag and Drop support
» Ability to copy members and files between different hosts and system types!
= Disconnected development support via iSeries projects
= User defined actions
» More functionality and substitution variables

.PRZ 31
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What's new in Version 5.0!

iISeries AD, IBM Toronto

m Remote Searching
» Search remote members for specific text
strings
= More support for accessing remote
Linux, Unix and Windows systems
» Table view
» User defined actions
= Much, much more

» Save passwords, message file support,
environment variables, ...

.PRZ 32
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wosc: RPG/CBLTools IR

s AD, IBM Toronto

»BPs, ISVs, and eclipse. ..
Great business opportunity for all!

IBM @server. For the next generation of e-business.



Plug-in development . ..

iISeries AD, IBM Toronto

= Extending the Workbench

» "Plugins" provide a mechanism for IBM and other software tool
vendors to add functions to the Eclipse Workbench and sell them as
products

= Ability to add new functions to the Workbench
= XML Tools, WebFacing, Remote Systems Explorer
= Ability to extend existing functions provided by other vendors
= |Series extensions to Web Tools
— SCM providing VCM adapters for source change control
= Extension points

= Business parnters can provide their own plugins for Eclipse

= Softlanding, Aldon to provide VCM adapters to integrate with their
existing source change systems... Other are working on it too.

= \We have provided extension points in our code (RSE) for
business partners to extend what we are doing

= Huge opportunity for BP

.PRZ 34

IBM @server. For the next generation of e-business.



WDSc: Java Tools

iISeries AD, IBM Toronto

» Java Development Tools (JDT)

IBM @server. For the next generation of e-business.



WDSc: Java Tools

iISeries AD, IBM Toronto

v/ Java Development Tools (JDT):

|
-in and offered as default

@ azzert[String.boolean) woid - Aszert

D2 azzertfboolean) woid - Aezert

@ azzertE qualsObject Object] woid - Azsert

D azzertE quals(String,Object.Object]  woid - Aszgert
D azzertE quals(String boolean,boolean]  woid - Azgzert

@ azsertEquals(String. byte byte]  void - Assert a d evel (@) p m ent

2 azzertk qualz[String.char.char] woid - Aszert I;I S
| »

Jd

v Package view
v Qutline view: m
» Java Editor

L& a=sert T rue(boolean] woid - Assert i
() AzsertTest - junit.t Bzzertz that a condition iz brue. [Fikiza't it rows an .ﬂ.ssertinnFailedEerI
| deprecatedgize azzertTue

v JavaDoc shown as hover help

H} Packages v X
v F3 to open selected class o
» Refactoring support e it enensios

83 junit. framework
B Uit runner
: unit. zamples
----- ] AT ests java

v Rename updates all references
» Incremental compile

v When Ctrl+S pressed in editor - SimpleTestjava

v Or on demand via Build Project action m...ég'i.ifﬁllf e

.PRZ
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Java Tools Not There

iISeries AD, IBM Toronto

v/ Not all VAJava function Is available yet:
e Visual Composition Editor... coming soon

e DataBase Beans

» Actually, there are replacements! Just no visual
metaphor

» See com.ibm.db.beans: DBSelect, DBProcedureCall,
DBModify

» Also a Database access wizard in Web Tools

e SOQLJ support
e Stored Procedure Builder

v/ For VAJava migration...

» Wwww.ibm.com/software/wsdd

v "VisualAge for Java coexistence with WebSphere Studio Application Developer"
v http:/Mmww7b.boulder.ibm.com/wsdd/library/techarticles/0110_searle/searle.html

.PRZ 37
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Java Tools for iSeries

iISeries AD, IBM Toronto

v/ 1Series extensions for Java
e Import and export from/to remote system
e Remote Compile and Run
e Remote Debug
e Program Call wizard

e Toolbox for Java built-in

» As an Eclipse Java project (ie: easy to add to
classpath of your project!)

» Integrated help

» Runnable samples

e Supplied Java-beans

» Swing GUI beans (dspf-like functionality)
» DFU beans (database access)
» Object list beans (lib, obj, mbr, field, record lists)

.PRZ 38
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Java Tools for iSeries

iISeries AD, IBM Toronto

v/ Program Call Wizard

e Given signature of *PGM or *SRVPGM proc:
» Generate Java Bean to call it

e Steps:
» 1. Select Java/Web/WebFacing project

» 2. Select package
» 3. Use File->New->Other...

v ...1Series Java Program Call Bean

.PRZ 39
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Java Tools for iSeries

Select

Thiz wizard generates Java beans to call iSeries programs or procedures.

.PRZ

- W5

- Data

- Java

= Plug-in O
- Hemote |
- Server
- Simple
el

- Wwieh Ser
- wiehFac
ML

[+ Example:

Program Call Wizard

e—————

Define program definitions for pour program or procedure

iISeries AD, IBM Toronto

Fragram call definitionz

Irnpart PCRL. ..

Synchronize Al |

LI

&dd Program... | &dd Parameter... | &dd Structure. ..

Edit Program
Java bean name:
Fragram object;
Librany:

Program bype:
Entry poitt;
Return type:

Thread safe:;

Source location:

VPEINIe; Press
0)5¢

Browsze. .. |

|M wProgram

|GETDLVSTS

|PHILDEMD

| “PGM ]

|

I vaid j

I false j
[

Finizh Cancel

IDJIVI (T/DUL YUL, 1'UL UIT IITAL EULTLAUUILL UL TTUUD




Enter Parameter Info

&dd Program... II Add Ealameter... | Add Structure. . |

DEfRE

LPaldMELENS

iISeries AD, IBM Toronto

Add Parameter

Farameter name: I Add Structure
D' ata type: character j S s I
Structure name: j Count: |
Length: j IJzage: Iinput % output N
Frecisian: j | Qutput size: |
4 Cournt: | > O fOr Mir. wersion: |
U zage: inpuit & output j ‘ array bz, version |
Iritial walue:; I Offset: I
Offzet from; |
[~ Advanced...
i ' Specify...
_ Specify databasze reference field PECIY Be slre tO press OK for
) Show database field definition =] e eaCh pal’ameter / structure

Frogram call definitions

- ! retCode
o { nbiCodes

- { divCodes
e Mext =

PRZ 41

IBM @server. For the next seneration of e-business.



Final Page N

Program Call Wizard |

Create iS5eries Program Call Java bean and PCHL file
Specify the location where the Java bean and PCML file to be generated. g

LWhere ie generaie Javaiclass

Folder: Browse...

Package: Icu&tnmer.demn j Browsze...

RIS ORI\ here to generate PEMIL file T

Generate Java beans and a PCML file faor:

¥ Java application

- SEIECt WEN SEVICES teI0ENnEaterJava code epiiized
o uselnitheVenrsenicasanizarnd

Thesze filez will be generated by the wizard: TO Change pal’am Ete IS N
MyFrogiam peml SUmman/eiriies |aer:

yProgram. mpoml . )
kyProgramServices. java that WI” be (] Return to leard

byProgram.java

generated e Use Import PCIVIL...

The clazz path of the specitied project will be automatically updated. button
Generated Java beans require the following JAR files at compile brme and run brme: RURAMmenmies you
ECLIPSE_HOME /plugine/com. ibr. etoolz. izenes. toolboxruntime. 400, jar W| I I need tO
ECLIPSE_HOME /plugine/com. ibm. etoolz. izenes. webtoolzAibAwdtd 000, jar )

ECLIPSE_HOME /pluging/com.ibrn. etools. websphere, iuntime/lib serces. jar deploy Wlth yOUI‘

ECLIPSE_HOME /pluging/com.ibm. etoolz. websphere. untime b j2ee. jar 00) d a

< Back | Hiewt > | Finizh Cancel |
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File Edit Perspective Project

Cebug  Window  Help

Generated Java Bean

- ¥ Java - Development Studio Client

- |

=

| B | aE

Fackages: Phillavalemo

i

=8} customer.dema
[J] Customer java

|E|El = A& | B |

Aelels
[eguired
filesite
PlOJECH
classpath

. using
Ditem[s]: gen'd
pEean

[J] MyProgram.java

|]_"| b yuProgramB esul.java
[J] MyProgramServices. java
tyPragram. mperml
byPragram. perl

Eﬂ--m JRE_LIB - E:%wDSCWSSD
Eﬂ--ﬁh ECLIPSE_HOME /plugins/caon
Eﬂ--ﬁ}l ECLIPSE_HOME fpluginz/con
Eﬂ--@ ECLIPSE_HOME /plugins/caon
Eﬂ--ﬁ}:., ECLIPSE_HOME /pluginz/con

Examp@

|E-K- e ® vERE T
v x || ] MyProgram java X :E— Outlite 20 & @ x
package customer . demo: A0 H customer.dema
import jawva. math. *: ‘s import declarations
import com.ibm. as=400 access. *; =@ MyProgram
import com.ibm. connector  as400 . ProgramCallBean; —| - @ MyProgram()
import com.ibm. connector . asd400.ProgramCallRecord || L. @ getRetCodel)
import com.ibm. connector . asd400.ProgramCallStruct || 0 ® getNbiCodes]]
public clas=s MyProgram extend=s ProgramCallBean || 77 @ getDkCodes(int]
L e 2 invake()
N | I 2 zetConnectionD atalds 400)
?ubll': MyProgram(y b ©  zetConmectionD ataSting, Sting, Sting)
super(): @ get.-'—‘-tSfiDDE_II:qen:t_[]
setPocnllane( "custoner . deno . MyFProgran"y; || @ setlibraryList[String[])
getProgramlane "MvProgran®y:; | e @ dizconnect(]
L | e @ zetTraceEnabled{boaolean)
public Integer getRetCodesl) >Setconnec;tlonData('")
-l- - . . . .
<I | LIJ »t0 [dentlfy signon info
package cust oner . denp; > SetleraryUSt(...)
publ e class Test MyProgram »to set runtime library list
public static void main(String[] args) FSEtXXX()
{ .
M/Program test = new MyProgran(); »{0 set Input parameters
test.set ConnectionData(" MYSYSTEM', "MYUSERI D', "MYPASSWORD'); | . invoke()
test. set Li braryList(new String[] {"PH LDEMD'});
test.invoke(); \br God » 10 run program
int nbrResults = test.getNorCodes().intValue();
Systemout.println("Nor Codes: " + nbrResults); > getXXX()

for (int idx=0;

i dx<nbr Resul t's;

Systemout.println(" code "

i dx++)

+idx + "0 "+

test . get Dl vCodes(i dx).trim()):

»10 get output parameters
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WDSc: Web Tools

iISeries AD, IBM Toronto

» \Web Tools

.PRZ 44
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WDSc: WSSDa Web Tools

iISeries AD, IBM Toronto

v/ Web projects
e J2EE-defined folder structure for Web Apps
e Superset of Java projects (inherits Java Tools)
e Automatic creation/maintainence of web.xml file

e Editor support

» Create/Edit/Validate/Debug JSP and HTML files
» Images and animation
» Cascading Syle Sheets (CSS)

e Import/Export from/to a variety of sources
» HTTP/FTP/WAR/EAR
e Link viewing and management

» Converting links, flagging broken links, and fixing up
links as linked resources are moved or renamed

PRZ 45
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WDSc: WSSDa Web Wizard< e

iISeries AD, IBM Toronto

v/ Java Bean Web Pages Wizard

e Input: Java Bean

e Output:
» Input JSP page prompting for input properties
» Qutput JSP page displaying output properties
» Servlet that ties them together

v/ Database Web Pages Wizard

e Input: SQL Query Statement (sub-wizard)
e Output:
> Input JSP page prompting for input parameters
» Qutput JSP page displaying output data
» Servlet that ties them together

.PRZ 46
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- ¥ Web - Development Studio Client
—

File Edit Perspective Project ‘Window Help

Web Perspective

s

H-|EHEE| R %]

P SRR S S | B

“Wiscellaneous

iISeries AD, IBM Toronto:
M=] E3

wa | < | =

FE-—EEO| BR[| |&:EMm

=

Bl =< | B 7 u|Aa aF

NFSOUNCE

VALTOE=""":

BRkSVIew

5@ Style Sheet
ﬁ Script

Cezlllgpy o
IMagES for

h
=ﬂ
Custornerd nputForm. html

e ncludenn
VoL PagE

ki

ﬁ ®E Navigator G v X 1:'—1| Cuztomerl nputFarm. html > ]
% Elﬁ Myta'ebProject a | | CustamerlnputFarm.html - Customer Central Page DeSIQner
- =l source = . :
E{Z abo E3¢|——Input Fields——:> Work
e def §4<TAELE border="0": mode: or
i -] Customer java 5« TEBODY » L
e [F CustomerContoller =1 <TR:
- M) CustomerControlierjava || 56 o WNSIWN G mede
@ CustomeryiewB ean. java Ea q-
% o [0 MyServet java £q {;TIJ.i} '
-z webdpplication 1] <TD
i #-= theme 61 «INFUT HAME=" YTPE="text" SIZE="20" HMAXLEWNGTH="40"
o S, e =1 63 TR
R | istomer| nputForm, html 64 TEODT >
;~= CustomerFesultz.jzp GBS TABLE »
2] .classpath i |EBUNlt=in
(2] .websettings - g
&l Gallery *®
EZl---:EI Image
B Wallpaper 7 Links
- Ee wiebart
Bl Saund

—_— EI b azter czs
E— CustomerController

_?....

javascript: submitForm()

SHBWS
[elaenships

ELWEEN TIIES;
Including
ypertext

] aller_l,ll Ouatline Tasks | Froperties lLinks] Thurnbnail | Styles | Colors

ks

big s EaiteyyERpeba pplicationCustomer nputF arm. himl
11r] < .




WDSc: Run On Server

iISeries AD, IBM Toronto

v/ Run On Server
e Now this I1Is VERY COOL!

v/ When ready to test your Web app

e Right click on initial html or jsp file
» or whole project, which implies the index.html file

e Select "Run on Project”
e \Wait for the magic...

v/ Your Web application will run!

e Opens Server perspective

» Publishes it to built-in copy of WAS
» Starts built-in copy of WAS
» Brings up a Web Browser
» Runs your application!!
v Tip: you can set breakpoints in your Java code!
IBM @server. For the next generation of e-business.
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/ a » / af. 7

- ¥ Server - Development Studio Client

File Edit Perspective Project Debug  “Window Help

BS-HEE | Xy|aE- o BN | H|(H-X-| v
- Tgb My Project E o Navigater v x| |[CREEET X l
@ MuSererProject % & (@ CaDemoTest sl W it/ Alocalh ozt 8080/ My ebProject/Customerl nputF orm. htm
|___| ﬁ I b Chnimns — #-1a CarDemoT estégain

- ¥ Server - Development Studio Client

File Edit Perspective Project Debug ‘Window  Help

HE & |[ X% |- 0BRSS B (H-X-] 9

'Eg_; M avigator w» 3 || i@ WebBrowser X

ﬁ CallemoT est 21 | |hitp: Aocalhost: 30804y ebProject/Customer nputFarm. kbl | @ | <= P 0 S

ﬁ CarDemaT estigain I J | & | D
+-1@ Chicago -

+-1a DefaullEAR . =
= Ao | Customer Details

'[; iy Project !
'@ iy erverProject
Elﬁ tuitfebProject

EEEIEE

----- --E- SOLCE

- Bz webdpplication Customer ID: 102201
e | ﬂ—l Customer Address: Addr 102201
' Server Configuration N Customer Name: Name 102201 -
El[ﬁ Semver Instances Done
: @ myServerinstancedndCaonfigy = :
: - e WebSphere v4.0 Test Enviro Lansols X
El--f% Server Configurations Sroup I SEVEQQD91I: [Servlet LOG]: InwvolkerServlet: init -

- g IhstarcetindConfig | DT ransport A SEVED171I: Transport http i= listening on port & 080

% .:f hesrvir ns;;c. nt tf:'n IEL e A& WSYRO023I: Server Default Server open for e-business

4ol e ED=pNETE SOMINEISIVE L =y onp I SEYENQD91I: [Serwlet LOG]: CustomerController: init —
1 | 3
1 | | ﬂ SE-'WETS|DE|:IL.IQ|PIDDESSESIEDHSD|EJ"\-"EriEI|:I|ES |
ategy.PRZ 49
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WDSc: iSeries Web Tools

iISeries AD, IBM Toronto

v/ Tools optimized for 1Series developers!

e \Web Interaction wizard

» Input: *PGM or ILE proc parameter information
» Output:

v Input JSP page prompting for input properties

v Qutput JSP page displaying output properties

v Java Bean for calling the *PGM or ILE procedure

v Servlet that ties them together

e Host Information wizard

» Set runtime information such as library list and
sign-on information, to be used by glue generated
by all Web Interaction wizards for this Web project

e Visual Custom Tags (Web GUI Widgets)

» Web GUI Widgets that support DSPF-like attributes
such as error checking by datatype, and edit-code
and edit-word

.PRZ 50
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Web Interaction Wizard

Design the Input Form
Specify the page properties and the input parameters that the generated ‘Web page will expose to the uzer for input. Q“%

Ta- Navigator - X ::ﬂ “CustornerB alancelnput. jzp X
L——_Iﬁ MyiadebProject
EHE: sOLrce
=== abc
T E-G def Customer Central ¢
----- 0] Customner.java
----- 0] CustomerBalanceServiet java R L L L L L e P P PP P PP PP

a | | CustomerBalancelnput.jzp - Customer Central # | D - | Standard =

----- m CuztomerController.java ; 1d: EI :
----- 0] CustomerviewB ean java
----- 0] MySerdet java E

----- 0] ProgramPecord_CustomerBalance. java E

== webipplication :
[+-{z= theme ST
= WEB-IMF

CugtomerB alancelnput. jzp
----- = ]| Customerk alanceResults.jsp
----- v | Cugtamer nputForm. html
----- e | CustomerBesults jzp

""" tyw'ebProject. pomi Design] source | Preview
----- o ]| setdebug.jzp :
2] wokd00tr js ) Links

----- clazzpath - ﬂ

W \—b | widt400br j

. CuztomerB alanceServet B
CuztomerB alancelnput jzp 5

= 5

X




File Edit

- ¥ Web - Development Studio Client

Perspective  Project

No More DTCs

Toolbar | Insert JSP Format  Table  Fra -

N E |

AS /400 =atryfield DTC Propetrties

.......................

Field name

1 BT o

Design-time Control

345 /400 Checkbox DTC
W 45 /400 Combobox DTC

1 45/400 Entryfield DTC
A ASA00 Label DTC
=l 457400 Listbox DTC

Field bype
|7 * Mommal

™ Hidden £®145/400 MLE DTC

Vizible width IE':I

4] 45400 Pushbutton J

[

et |left

[~ Read only [~ Capslock
| [ Field data
DB Reference ... | .
— Formatting I DSOS S DN o ibrm. etools isene.. MCheckB oxd00. ooy
* None
Length_ " ] Cancel Help
o € Edit code
[rata bwpe . < ‘
CHARACTER 7| ParametgffTi00E =l — i
i,'" E -‘l 0
g -Enker J
a vk O
Diirectionality MOME j ﬂ
| E— . CustomerB alance et
lancel nput.j=p
" o
Ok, Cancel Aol | Help . |
SPO8-Stateqy.PRZ
— S - . Wmﬂq%“ 5':],'|E:S||:EI|EI[S

onto




VTCs ... No more DTCs

iISeries AD, IBM Toronto

1@- wWeb - WebSphere Nevelopment Studio Client for iSeries

File Edit Toolba @ Format Table Frame Page Toc

| - & ¢ & Onk... Chr40)
| ﬁ&;’ @I\. | o # Anchor...
e Image File *
i %5 J2EEMavid  Background Image File 4
Bl - wet Background Music 4
ES B Paragraph :
ey B3 Lisk ¥
"; H-{= B Iable... Chrl+T
-G ;
—— ¢ & — Horizonkal Rule

-y

H-{Z Form and Input Fields 4

3 Web Compgnents...

.1 Lavaou
mallery
__f-"_I — Line Break. .. Ckrl+Enter
T = Ilnzlage Special Characters, ..
£ Bl Mon-breaking Space Ctrl+5hift+5Space
[ Butt E"E”' ;
g Teor Keyword. ..
g il.lus F Date and Time...
e ine
-3 Pho 251 :
S Others E
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VTCs... No more DTCS

iISeries AD, IBM Toronto

Same selection. .. Better

look!
X

[JButkon
EImage Button
B Combo Box
f] selection Box
W Check Boz
E Text Area

(¥ Radio Button Group
=

| Tmage
%Hyperlink
Table

0] 4 | Cancel |
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Web Wizard Struts based ... I
M.V.C

View Model

Controller

0
0
E|Cus1‘1n1'er'1... - | Xl :
0
[

P E Normall HTML Saurce PfEViEWl
L |D0ne

Struts
Framework

Welcome to ABC!!

(]
Submit | eeeee | :I :

JSPs & HTML:

Traffic Controller
IBM @server. For the next generation of e-business. .
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WDSc: Web Services Tools .

s AD, IBM Toronto

»\Web Services Tools
» XML Tools
» Database Tools

IBM @server. For the next generation of e-business.



WDSc: Web Service Tools

iISeries AD, IBM Toronto

v/ Consume/Construct Web services:

e Discover

» Browse UDDI registry to locate existing services
» Generate Java Bean Proxy for existing services

e Create/Transform
» Create new Web services from Java Beans, databases
v Including Java Beans output from iSeries ProgramCall wizard

e Deploy
» Deploy Web service to WebSphere or Tomcat for testing

e [est

» Built-in test client allows for immmediate testing of
local/remote Web services

e Publish
» Publish Web services to UDDI registry

.PRZ 57
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WDSc: XML Tools

iISeries AD, IBM Toronto

v/ XML Perspective and XML Tools

e XML Editor
» For creating and viewing XML files

e DTD Editor
» For creating/viewing Document Type Definitions

e XML Schema Editor
» For creating, viewing and editing XML Schemas

e XML to XML Mapping Editor
» To map one+ source XML files to a target XML file

e XSL Trace Editor
» To visually step through an XSL transform

e XML and SQL Query Wizard
» To create an XML file from an SQL query

e RDB to XML Mapping Editor
» To map one+ relational tables to a target XML file
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WDSc: XML Editor

iISeries AD, IBM Toronto

- ¥ %ML - Development Studio Client
File Edit FPerspective Project ‘Window Help
- EHEES X bR RGR v a8 R |F[=
% 2 ;----1?:3 wril . wergion=""1.0" encoding="LUTF-8"

-<e» booklis E-4e» booklist
i) =l-«e» book El-«e> l:":"z'lf‘
E-ﬂ ixer author e4ar izhin 12345678
st |é|---:e_> bioak g----mh title #ML By Dummies
E.?b 4@ é"{;-isnhnsuthnr One B. Dummy
@ eqdr jzbn 98765432

Ledar title #3L With Style
0 <o cuthor N 5 ©: .
B BookList sl |
5 Navigato M Tasks [ 1:7zml wersion="1.0" encoding="UTF-8"7: -
[c]1 [ DesNgt 2<booklist:
Sl MyxMLProject ; 3 ¢book 1sbn="12345678" title="XML By Dummies":
- rojee 4 fauthor:One B, Dummy< author:
[-{= MuFalder = ¢ “Book >
""" b (book 1sbn="98765432" title="¥5L With Stvyle":
cauthor:Some Bah D¢ author:
<bool

ooklist:

10

Source
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- ¥ XML - Development Studio Client
File Edit

Perspective Project

Window  Help

T |

BE 2% BB RGH S 6| GK

I S s e s s = s

=1 (8] MewxMLSchema

-y ook,
&%,
. E_ﬁ. author
ey booklist
5%,
~.4e» book

L v x
Add Annotation
fdd Complex Type
Add Simple Type
Add Global Element
Add Global Attribute
Add Attribute Group
Add Group

(5] MewiMLS chema.xsd X

Add Include
Add Impark
Add Redefine
Add Motation

Undo
Hedo

Element name: Iisl:ln

— Type infarmation
& Built-in zsimple type
™ User-defined simple twpe
" User-defined complex type

I strinig

[T Abstract [~ Millable

—alue
{* Fixed
™ Default

kirirmum: I

b aximuam: I

%g_; M avigator

-l MyMLProject

== MyFolder

Block: I

j Subztitution group:; I

Final: I

j Form qualifin::atin:un:l

D eszign §5ource

[DESIGNMOEE
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iISeries AD, IBM Toronto

- ¥ XML - Development Studio Client
File Edit Perspective Project xS0 Window Help

SMELT L T ¥ LRI

:E‘ Outline E’lz el B New<MLSchemas
ElEj NewtMLE chema l<7zmnl wersion="1.0" encoding="UTF-8"7:

...... targetNamespace="http:/“www. 1bn. com”
----- znln=s HewiMl5chema="http:~“www. ibm.con" »

i ¢zlement name="booklist" type="HewillSchema: booklist" @< =lemsnt:
i ¢elenent name="book" type="NewiMLSchensa: book':< /element:
{zlement name="ishn" type="string":{ elemsnt:

el book ¢elenent name="title" type="string":<- elemnent:

=1-"8g ¢elenent name="author" type="string":{ elemnent:

- ¢ gf_ﬁ. authar
& in ]

i ttle hE ccomplexType name="book":

=ty booklist 215 {ZEQUENCE

= L6 {zlement ref="HewKHLSchema:authur".minOccurs="l" maxloours="1" < /elenent »
<85 book ¢elemnent ref="NewilLSchema:@ isbn" minfccurs="1" maxlccurs="1":< elenent:
celenent ref="NewiMLSchena: title" minOccurs="1" maxlccurs="10":{ =lement:

{ S =EqUENCE ¥

“Eg‘: M avigatar A ¢/conplexType:

oot sconplexType name="booklist":
=-1a# MyrhLProject e ¢zequence minlocurs="1" naxOccurs="unbounded":

== MyFolder dd ¢elemnent name="book" type="NewiMLSchens: book":< slemsnt
i e { S zequUence

_| 2] ¢ complexType» -
8 LIJ

Desr{Eouce]

‘ Source mede
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WDSc: XML-to-XML Editor

iISeries AD, IBM Toronto

Mew
Lo To
Cpen
Cpen With 3

Copy

Mowe

Rename
Delete

&add Bookmark

Refresh From Local

BLm an Server
x5LT ...

Generake

Tean

Compare With 2
Replace With k
apply ©SL 3

Properties

(G [UENErate
-« Sioiptile

- ¥ XML - Development Studio Client
File Edit Perspective Project Window Help

v/ XML-to-XML Mapping Editor

B5]3% 008D AR 9

¢ 2l

1l| & iFi| I iﬁ5| e

HEZ - -

St mlmap.sms X |

b cdhitle <-» newcditle

o] Source - ﬁ}'

4+ O 26 » (A Target

Wl 4 Ee -

4] I

'fg_; M avigatar v

ey ¥ description

|E|‘H* CO ¢ .ED | = @ 1 Lhitle E||E| ¥ newodtte
H- artigt <~ artist -<ex CDLb =48 Collections
bl o ile e D =48> Library
EB /.--H descriphion <--» de ------ e atist el CD
f! _______ '|'" t ...... t?' |
gy lille @ " artish
'i' ....... " E;? formnat """" { E?b fitle:

weqps ! description

b L Scher

- wmimapamy

9 T a .
ey descrphi.. ey description

= Overview @ i
E1 MuMLProject o | | Target Source Applied Funchion/Grouping +
: EI{E byFolder EI—*E* Library
) BookListml reef LD f D
] BookQrder.sml @ gt B arhist Va in S
""" @ MNewDTD.dtd ":E:. hitle ':E? hitle pp g

L

q b |

—

Selected Mapping: cdtitle/COLb/CD/desciption <-» newcdtitle/Collections/Libran/CO/description
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WDSc: XML-to-XML Editor

iISeries AD, IBM Toronto

v/ XML-to-XML Mapping Editor

- § XML - Development Studio Client

File Edit Ferspective Project Window Help
N HES D% | (arE N RDR| &
ﬁ 5 Outline - X qif}g:-:mlmap.:-:m:-: | ® mimap.ss
_ ._ H H . _q.\:l
% [#-4e> izl attibub-—= 44 < |— Comnposed element template ——:3
: : = 45 <¢m=]: template match="CD":
E) ‘I I ’ 46 (=] copy:
irs _ . 55:35?. tE=] attribute name="artist":
@ || 5 Navigator v X )dB =l value—of select="artist- text(i"
B c/E=l attribute:
EH : 50 ¢zl for—-sach =zelect="title":
T || 21 MyHMLProject )| 51 ctitles
I_ E-Z= MuFolder 52 <=l :valus—of select="text( )"
| [¥] BoakList sl 53 crtitles
’ 54 cr =zl for—-each:
BN | %] BookOrder.xml EG ¢description:
57 [ 0] MewDTD.dtd Ch sx=] value—of =select="description te=xt()"~:
— |l i (8] MewsMLScher 57 {s/description:
..... 58 <s®w=]  copy
EEI Amimap. Am 59 < E=l:template:
----- B3 wrnlmap, sl - -
L] b b
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WDSc: Database Tools

iISeries AD, IBM Toronto

+/ Database Tools:

e Relational Schema Center
» Provides views geared for DBAS to
v Create Databases
v Create Tables/Views/Indexes/Keys
v Generate DDL

» Online and offline support for working with databases
v Metadata generated as XMI

e SOL Query Builder

» Visually construct SQL statements
v Insert, update, delete, select supported
v Metadata generated as XM|

e SQL/XML mapping
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WDSc: WebFacing

iISeries AD, IBM Toronto

» WebFacing
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WebFacing: Before/after

iISeries AD, IBM Toronto

I (=3

|ﬁm|m:; 2| 8l 4|

Qut | Cicket | Sure |

A= Edt Trarfer Appearance Comninishon  #ssst Window Hep

JE’j Fig) @[% RN

F'-:slr { Aacy | Hep F!n-cnru

=101 x|

Edit  Wiew Favarites Tools Help |“
wBack » = - ) [2] &} | Qsearch GFavorites CHstory By & 5] B
1

J Links @ TBM Standard Software & 18M Standard Software Installer & I6M Business Transformation & ]18M Internal Help & Customize Links »;

File:
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WebFacing
v Whatitis:

e Development Tool

» Converts DSPFs to Web Ul
e Runtime Intercept

» Redirect *PGM 5250 1I/0O to Web UI
v What Is not;

iISeries AD, IBM Toronto

il

) |
=
A4

e 5250 datastream converter!

» No 5250 datastream ever created

¢

»*PGM raw data buffers fed directly to Web Ul
» Conversion hit at development time, not runtime
v Why:

.PRZ

e For BPs/1SVs to quickly convert to Web

» No limitation to customization of output
» NO-cost runtime, ubiquitous tool
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..\WebFacing

iISeries AD, IBM Toronto

v/ WebFacing and Eclipse

e \/ObR1:

» first IBM tool based on Eclipse!
» "first edition" status

o V4.0 WDSc:
» "First edition" status is over!
» Inherits and leverages all Web and Java tooling
» Leverages built-in WebSphere Test Environment
» Optimized for 4.0 of WAS
» Many functional and performance enhancements

e V5.0 WDSCc:
» "Second edition"
» More later . . .
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WebFacing Phase 2..

iISeries AD, IBM Toronto:

_+/ Major focus on client-side performance

e More efficient HTML and JavaScript
» Faster download and rendering time

v/ Major focus on client-side styling

e \Web-site style and application-area style
» Easier to imbed WebFaced app in corporate style

» Much better IBM-supplied styles for both

» Better use of cascading style sheet
v Much easier to do application-wide tailoring

IelendertErst
EQItiont status; more...

WENEACIANS
[OCKIMEMeW!
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WebFacing Phase 2... Sy

N0

ennancements

_+/ Major focus on function fellife Saice

e All common keywords supported el

e Support for UIM help panels for F1 support

e Support for function keys (being pressed)

e Option to tie-in corporate logon page with single
or repeated signon

v/ Major focus on co-existence

e Support for

» IBM WebSphere Edge Server and Work Load
Management
» Policy Directory (front ending WAS clusters)

e Co-existence with other Web modules In same
Web session
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What's new in WebFacing 5.0 ?

iISeries AD, IBM Toronto

» Ability to generate Struts based WebFacing
applications

» Support Function keys displayed in DDS Window
» Conversion iIs faster based on the new RSE
communication layer

» Automatic configuration for setting the WebFacing
Web Application to use the unicode UTF8 encoding
scheme for multi-lingual support

» Support for WRKSPLF

» Ability to override or add function keys ot support
additional actions not defined in the RPG or
COBOL application

» Enable DDS Conversion for supporting user written
JSP Custom Tags

» New Styles view in the WebFacing perspective in
the IDE
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WDSc: WebFacing

iISeries AD, IBM Toronto

» \What about RPG?
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RPGIV. ..

iISeries AD, IBM Toronto

SN

31 digit support
Allow Char. Parmsfor
pullt-ins

J S Source File Support
b qualified accessto data

ar eas
PCML generation
Short form operators
|/0O enhancements

[ | = —~
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Give me your vote. ..

TOta/ number iSeries AD, IBM Toronto

/Vumber Of 5p F baly

Sorted by item nunber O/'/edb OtSJ76‘
T . a//Ol‘s-
i tem# votes 986 cost description . _Z

1 6 3% $10 H spec keyword EXTDEFS to use the internal fornat
of ext fields.

2 52 29% $30 RANGE and VALUES keywor ds.
3 15 8% $25 SORTA arrl {: arr2 ...} WTH key _arrl1 {: key arr2 ...}
4 25 14% $ 5 Extender on SORTA to reverse the order of sorting.
5 53 30% $ 5 DEBUE *RETVAL) to al | ow debuggi ng of procedure return valu
6 24 13% $ 5 OPTIONS(*VARTYPE) to bypass type match of procedure parns
7 91 51% $10 New Bl Fs WWESTD, 9ESTT, and %AESTZ.
8 35 19% $50 All ow dynam c resi zing of arrays and multi-occurrence DS.
9 33 18% $ 5 Format change on a LIKE define for numerics.
10 24 13% $10 New keyword, RECPREFI X, to prefix record-format nanes.
11 11 6% $10 DM*FIT) with overlay field.
12 27 15% $50 Multipl e-di nension arrays (expressions only).
13 5 2% $40 SPEC AL files to handle all 1/0O opcodes, including keyed c
14 29 16% $ 5 %FFSET builtin function returns offset of subfield.
15 20 11% $20 Miltiple array elenent initialization.
16 28 15% $10 Keyword EXTDESC, |i ke EXTFILE, but used at conpile tinme
17 12 6% $20 Dynam c specification of basing variable, ie "p->var".
18 21 11% $20 Option *ZERCFILL on %D TC to include | eadi ng zer os.
19 12 6% $20 Option to edit negative nunbers using parent heses.
.PRZ 20
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Possible items for VSR3 .. . IS

iISeries AD, IBM Toronto

m The selected items are:

- Allow dynamic resizing of arrays and multi-occurrence DS.

- Conversion of date/time/tstamp to numeric using %INT, %DEC.
- Second parameter on %TRIMX - char to trim.

= Option to pass trimmed string as parameter.

m |f time permits, high priority:
- Allow EXTPGM to be coded without a parameter.
- LEAVE-WHEN & ITER-WHEN: single-statement conditional leave or it

- DEBUG(*RETVAL) to allow debugging of procedure return values

m |f time permits, lower priority:
- Procedure name overloading based on parm types.
- EVALC move corresponding from one data structure to another.
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WDSc Summary

iISeries AD, IBM Toronto

» Summary of WDSc
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Why WDSc ?

iISeries AD, IBM Toronto

» ISeries to become a premier e-business server

» Deliver AD tool set to support the rapid expansion of
e-business applications for iSeries
» \Web-enable existing 5250 applications
» Build new e-business applications
» Port existing e-business applications from other servers

» Integrate all of the iSeries application development tools, IBM
and non-IBM to a common IDE

» Optimize and simplify J2EE application development

» One comprehensive intergrated iSeries host product
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Why WDSc ?

iISeries AD, IBM Toronto

e Consolidates all of the key iSeries AD tools into one
pervasive, attractively-priced product
® over 75 K copies of WDS shipped since 05/2001

® Leverages Eclipse to deliver an integration platform for all
ISeries tools, both IBM and 3rd party

® |Series extentions to make it easy to leverage and extend
ISeries programs for Web, Web-services and Java
development.

® WebFacing Tool is the easiest, quickest and most cost
effective way to create a Web interface to 5250 apps

® WebSphere Development Studio Advanced Edition
extends the WDS value proposition for creating
sophisticated J2EE applications
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Our Strategy .. .

iISeries AD, IBM Toronto

e Continue to consolidate the iSeries AD tools to the Eclipse IDE
e Consistant IDE for traditional and e-business development tools
e Ease of learning, ease of use
e Both IBM and 3rd party tools
e Leverage the advancement in the WebSphere Studio / Eclipse tools to
deliver value to the iSeries development community
e Continue to enhance our tools to make it easier for iSeries developers to
move to an e-business footing
e leveraging and extending iSeries legacy assets to create complex
Web services solutions and portal solutions
e Leverage Eclipse plug-ins to deliver value to all of the other
development tools

e Remote Systems Explorer delivers system access to all development
tools that are ecilpse enabled

.PRZ
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Integrations and 1SVs!

iISeries AD, IBM Toronto

e All of the IBM iSeries application development tools are consolidated in
WebSphere Development Studio for iSeries
e Continue to leverage other WebSphere tools for use for iSeries development
» Host Access Transformation Server (HATS)
» WebSphere Application Monitor
» WebSphere Workload Simulator
e Key iSeries tools vendors (ISVs) are integrating to WebSphere Development
Studio for iSeries
» Source control management tool vendors
« Aldon
e MKS
« SoftLanding
» Impact analysis - AbStract Probe
» Lansa
« Working with iSeries partners to deliver:
» New Web-enabled iSeries solutions
« \Web-enabling services to partners and customers
e e-learning for our e-business development tools
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New Technology, Tools

w Bulld Community!

/" Single IDE for the whole family!

e iISeries and non-iSeries

e Traditional RPG+COBOL

e Modern e-business

e Young and young-challenged

;‘E’ BUlld Excitement!

\/ Build/re-purpose awesome apps!
+/ Use awesome tools!
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Standards

iISeries AD, IBM Toronto

v/ Industry Standards Supported

e By WSSDa, WSAD and WDSc:
»EJB 1.1
> Servilet 2.2
»JSP 1.1
»JRE 1.3
» Web Services Definition Language (WSDL) 1.1
» Apache SOAP 2.1
» XML DTD 1.0 10/2000 Revision
» XML Namespaces 1/99 Version
» XML Schema 5/2001 Version
» HTML 4.01 (other levels should work)
» CSS2 (PageDesigner displays a subset)
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OUOTES

iISeries AD, IBM Toronto

> Quotes
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OUOTES

iISeries AD, IBM Toronto

> ASC IncC

» Chris Wilson, Director, Programming/Operation Tools

v "Eclipse is perhaps the single best idea we've seen out of IBM in years.
By leveraging it's experience with Java, IBM has created a plugin shell that
has a real chance of replacing Microsoft's Visual Studio as the standard
IDE in the industry. Despite its youth, Eclipse is the most powerful Java
IDE we have ever encountered.”

v"WDSC combines an outstanding industry standard version control in CVS
with tools like our ABSTRACT impact analysis to finally create a true
graphical development environment for the iSeries platform."

» LANSA InC

» Bill Benjamin, Vice President, Business Development
v"The goal of Eclipse to provide a seamless interface where developers can
leverage tools from multiple vendors is a great idea and is something that
will add value to our customers. Eclipse is a great way to make it easy for
ISeries customers to integrate WebSphere and leading development tools

like LANSA".
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OUOTES

> SoftLanding Systems ’

» Mark Phippard, Director of Development
v "Finally, an IDE done right! SoftLanding is very excited about the new

Eclipse-family of IDE's, including WDSc. We believe that these IDE's
represent a major step forward for our customers and all iSeries
customers and business partners. We are excited about the technology
and are firmly committed to contributing plug-ins for our TurnOver change
management product and to provide the best possible support for all
Eclipse-based development.”

> Republic Indemnity of America

» Bob Cancilla, IT Director. Also runs www.ignite400.org
v "I have never been so impressed with a product as | am with what | am
seeing in here. This is one of the most totally incredible products | have
ever seen in 30 years in the business."
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QUOTES e

iISeries AD, IBM Toronto

_» Mid-Comp International

» Robert A. Hare, WebSphere Team Development Manager
v "It Is very important in the development of our web enablement projects to
have all developers working from a common work bench. Using the WDSc
allows all areas of development to come together from RPG maintenance
and modifications to java code generation. The WebFacing tools and
wizards that generate Java allow legacy programmers to be far more
efficient helping bring the WebApplication to the client faster."

> Aldon Computer Group

» Dan Magid, Vice President
v "Aldon Computer Group is pleased to be working in partnership with IBM
to integrate Aldon Affiniti with the Eclipse open source workbench. Aldon
Affiniti's integration with Eclipse provides an easy way for developers to
combine the powerful, unified multi-platform change management system
of Aldon Affiniti with the wide range of developer tools available through
Eclipse.”
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More Information

iISeries AD, IBM Toronto

v/ Information Sources

1. www.ibm.com/software/ad/wds400
» As of June 4th

2. www.eclipse.org
» Eclipse and information about eclipse

3. www.ignite400.org
» Introduction to eclipse article

4. eServer 1Series magazine, July issue
» 3 articles on WDSc

. www.1bm.com/websphere/developer
» WebSphere Developer Domain
» Many articles on eclipse and WSWB and
WebSphere Studio configurations
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Ordering WDSc

v If you don't have WDS / WDT: S

1. Have i1Series serial #? Order 5722-WDS
2. No 1Series? Buy WDT client PID.

v If you have WDS and WDT:

1. Order refresh feature of 5722-\WDS:

Notin » 2655
Vour » Announced in June 4th RFA 36640

taetan v Ifyou have WDT client PID:

1. You will get WDSc 4.0 automatically
» Handled by Passport Advantage
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